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 Executive Summary 
The aim of this white paper is to centralize all sources of information in relation to the upgrade process and 
pathways to Citect SCADA 2018, from versions as early as CitectSCADA 5.21. 
Two main methods are described: 
▲ Offline upgrade 
▲ Online upgrade 
Pre-requisites and post upgrade considerations will also be discussed. 
  Introduction 
The purpose of this document is to outline best practices for upgrading to Citect SCADA 2018. It is also intended to 
provide you with links to various documentation and resources, to assist you in the upgrade process. 
 
In the first section of this white paper we will highlight the advantages of upgrading to the latest version, including 
the new features available in Citect SCADA 2018. 
 
Later, we will go into the system requirements and planning stage of the upgrade: what you will need to backup 
and keep from your current version, and what you will need for your new system to deliver optimum performance 
after the upgrade. 
 
After that we will describe how to upgrade one SCADA server. This will help us build the foundation for an online 
upgrade; in this process, you will need to upgrade a second server, allowing you to upgrade without any downtime. 
  
There will be two cases described for an online upgrade:  
 
Starting from Citect SCADA 7.20 SP4 / SP5A 
Starting from Citect SCADA 7.40 SP1 
 
There are minor differences that need to be taken into consideration when upgrading from these two starting 
points. 
 
Finally, we will describe the steps you need to take to help ensure the upgrade has been successful, as well as 
other changes you will need to make after your project is running stable on Citect SCADA 2018. 
 
  Benefits of Upgrading 
It is always recommended to keep your software applications updated to the latest version. There are general 
advantages of being on the latest release of Citect SCADA, as well as the new functionality in Citect SCADA 2018. 
  Why upgrade? 
▲ Operating System (OS) and System Compatibility 

Citect SCADA 2018 has been validated for Windows 10 and Windows Server 2016 . Please check our 
Compatibility Matrix for a comprehensive list of compatible OS. 

▲ Supportability and latest releases 
Most updates and fixes have been developed for Citect SCADA 2018. Versions 7.20, 7.30 and 7.40 have 
matured which means neither Service packs nor fixes are developed for versions in the mature phase and 
limited support will be provided. For more information on this, please check Citect SCADA’s Support 
Lifecycle. 
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▲ Access to new features 
Any new release of Citect SCADA will contain new and unique functionality and features that have been developed in order to satisfy market trends and our customer’s needs. 

  What’s new in Citect SCADA 2018 
Depending on your starting version, there will be a lot of features that might be new to you. 
Please refer to the help document for information on 2018 new features, see the topic “What’s New in 
Citect SCADA 2018” in the “Getting Started” section. 
 
You can also check all the details in the product documentation in the following section for previous 
releases: 
 

 
Getting Started > What's New in v7.x > Previous Releases. Also available online. 
 In this section of the document we will go into the details of the preparation steps required before you start 
the upgrade process. 
 
First we will introduce terminology and differentiate the different types of upgrade. Then, we will describe 
briefly the suggested upgrade path for different versions of Citect SCADA.  
Finally, we will enumerate the system requirements and files you need to get from your current system 
before you proceed to upgrade.   Planning your upgrade 

 Before you start thinking about upgrading there is one important question you need to answer: 
 

  
If the answer is yes, then an offline upgrade will be suitable for you. 
If the answer is no, then you require an online upgrade. 
 
The main difference between them is the resources and system requirements necessary to achieve it. 
 
To be able to conduct an online upgrade, you must have at the very least a pair of redundant servers. 
In the sections below, you will learn in detail about the two processes. Regardless of your desired option, you 
will need to learn how to do a offline upgrade, since this is required to execute an online upgrade.   Upgrade Path 
 Historically, some versions of Citect have included substantial changes to the product, which required 

incremental upgrades involving many intermediate steps between very distant versions (i.e. 5.21 to 7.20). 

You can visit Ideas@SCADA forum to find ideas that have already been proposed and vote for them, 
or to create new ideas for features. 

Can my system tolerate downtime and loss of data? 
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We have improved the upgrade code so that fewer steps are necessary to go from 5.21 to Citect SCADA 2018, and the number of necessary steps will once again depend on your answer to the question: Can my 
system tolerate loss of data? 
 
If the answer is yes, then you can upgrade your project from as early a version as 5.21, directly into Citect 
SCADA 2018. 
 
If the answer is no, then you need to follow an online upgrade process and you need to also follow an 
upgrade path that will depend on your starting version:  
 
If your starting version is previous to v7.20 SP4 
You need to restore your project into v7.20 SP4 or SP5A compile and run the project to restore and convert 
your historic alarm data. 
 
If your starting version is v7.30, v7.30SP1 
You need to restore your project into v7.40 SP1 and compile and run the project to restore and convert your 
historic alarm data. 
 If your starting version is v7.40 
Install SP1 and compile and run the project to restore and convert your historic alarm data. 

 
  
 
  Hardware Requirements 
 Selecting hardware is dependent upon several factors such as: 

▲ The role of the hardware in your SCADA system 
▲ The amount of I/O, Alarms, Trends and the frequency of change 
▲ Number of Clients (for Servers) 
▲ Server Clustering 
▲ Complexity of your user interface 
▲ Degree of customization 

Figure 1: Recommended upgrade path to avoid loss of data 
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The requirements below have been tested using a simulated SCADA system with 10 clients connected 
maintaining a server CPU load of less than 25% and should be used as a guideline only due to the impact of 
the factors listed earlier. 
PC Performance 
General PC performance will be affected by the major elements of CPU, RAM, Bus, and HDD speed. 
The clock speed no longer defines how powerful a CPU is; the required processor is defined according to an 
average CPU mark given by PassMark® Software. To check CPU performance, for example for a Core i3 
CPU, type "PassMark Core i3" in the search engine of your internet browser. This will give you the CPU's 
calculated performance as compared to other similar well-known processors. 
In general, it is recommended that computers in your SCADA network utilize no more than ~25% CPU in 
normal state. This allows the system to be responsive, and handle abnormal situations better. 
Client Recommendations 

CPU  
PassMark® 

Cores 
*1 

RAM HDD 
*2 

Graphics Screen  
Resolution 
*3 

Network 

2000 2 4 GB 10 GB DirectX 9 or later with 
WDDM 1.0 Driver,  
128 MB of dedicated 
VRAM 

1920 x 1080 100 Mb 

  
                   1.       The complexity of your pages such as the number of graphical animations and Cicode running in the 

background will impact your client CPU choice. It is recommended to use a higher performing PC 
with high clock speed when building complex user interfaces. As a guidance, the following will 
require high clock speed to maintain a Client CPU load of less than 25% on a single core: 

                                     a.    HD user interface with 50 complex genies 
                                     b.    UHD4K user interface with 100 complex genies 

  
                   2.       If the Deployment feature is being used, the HDD needs to have the required space for the number of 

configured version+2 of the project. 
  

                   3.       Citect SCADA supports lower and higher resolutions including 4K UHD Resolution (3840 x 2160). A 4K UHD will require a high clock speed CPU. 
  

                   4.       A multi-monitor client will typically require a higher clock speed CPU and more memory. 
  
Server Recommendation 

I/O per 
Server *1 

CPU 
PassMark® 

Cores RAM HDD *2 
*3 

Graphics Screen  
Resolution 

Network 

Compact 
(<1,500 pts) 

1800 1 4 GB 10 GB DirectX 9 or later with WDDM 1.0 
Driver, 
64 MB of dedicated 
VRAM 

1920 x 
1080 

100 Mb 
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Small  
(<15,000 pts) 

4500 4 8 GB 20 GB DirectX 9 or later with WDDM 1.0 
Driver, 
128 MB of dedicated 
VRAM 

1920 x 
1080 

100 Mb 

Medium  
(<50,000 pts) 

8000 4 8 GB 100 GB DirectX 9 or later 
with WDDM 1.0 
Driver, 128 MB of dedicated 
VRAM 

1920 x 
1080 

100 Mb 

Large  (<200,000 
pts) 

10000 8 16 GB 500 GB DirectX 9 or later with WDDM 1.0 
Driver, 
128 MB of dedicated 
VRAM 

1920 x 
1080 

1 Gb 

 
                   1.       This is a recommendation for a single server only running I/O, alarms, trends and reports. For larger 

systems, services can be distributed to their own PC and/or clustering can be used to add additional 
servers. System resources of CPU and Memory should be increased when: 

                                    ·          Using clustering 
                                    ·          There is high rate of change of data (I/O or Alarms) 

  
                   2.       If the Deployment feature is being used, the HDD needs to have the required space for the number of 

configured versions+ 2 of your project. 
  

                   3.       Disk space is an estimate only and includes: 
                                    ·          Runtime components 
                                    ·          Compiled project 
                                    ·          20% of the I/O trending with a change on average every 10 seconds, 24 x 7 for 3 months. 
                                    ·          Alarm changes equal to the number of I/O changing per day 

  

1.     The exception to the 10-client simulation is the HMI role, with a Server/Client combination 
operating without networking.  
2.     Refer to the detailed Hardware Requirements in the Citect SCADA 2018 Installation Guide to 
better gauge hardware recommendations specific to the size of your SCADA system. 
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Engineering Workstation Recommendation 
Total 
System 
Size 

CPU 
PassMark® 

Cores RAM HDD *1  
*2 *3 

Graphics Screen 
Resolution *4 

Network 

Compact  
(<1,500 pts) 

2000 2 8 GB 10 GB DirectX 9 or later with WDDM 1.0 
Driver, 128 MB of 
dedicated VRAM 

1920 x 1080 100 Mb 

Small  
(<15,000 pts) 

2000 2 8 GB 20 GB DirectX 9 or later 
with WDDM 1.0 Driver, 128 MB of 
dedicated VRAM. 

1920 x 1080 100 Mb 

Medium  
(<50,000 pts) 

4250 4 8 GB 50 GB DirectX 9 or later with WDDM 1.0 
Driver, 128 MB of 
dedicated VRAM. 

1920 x 1080 100 Mb 

Large  
(<500,000 
pts) 

4250 4 8 GB 50 GB DirectX 9 or later 
with WDDM 1.0 Driver, 128 MB of 
dedicated VRAM. 

1920 x 1080 100 Mb 

Huge  (>500,000 
pts) 

8000 4 8 GB 100 GB DirectX 9 or later with WDDM 1.0 
Driver, 128 MB of 
dedicated VRAM. 

1920 x 1080 100 Mb *5 

  
                      1.       SSD is recommended for Engineering machines for a smoother and faster experience. If a non-SSD 

is used, select a minimum RPM of 7200. 
  

                      2.       If the Engineering machine is being used as a Deployment Server, the size of the HDD will 
determine how many versions of the system you can retain. 

  
                      3.       Disk space is an estimate only and includes: 
                                          ·       Full Citect SCADA installation including optional components and documentation 
                                          ·       Project Assets for the specified system size 

  
                      4.       Citect Studio is designed for a minimum desktop resolution of 1920 x 1080. 

  
                      5.       If the Engineering machine is being used as a Deployment Server, a 1Gb network connection is 

recommended. 
  
HMI Recommendation 

System 
 Size*1 

CPU  
PassMark® 

Cores RAM HDD Graphics Screen 
Resolution 

Network 

Compact  
(<1,200 pts) 

1400 1 8 GB 10 GB DirectX 9 or later with WDDM 1.0 
Driver, 64 MB of 
dedicated VRAM 

1920 x 1080 n/a 

  
                      1.       HMI Client/Server combination. 

Table 1: Recommended hardware requirements for Citect SCADA 2018 
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 Software Requirements 
Citect SCADA 2018 can be run on: 

▲ Windows® 7 SP1 (64 bit only) 
▲ Windows® 8.1 (64 bit only) 
▲ Windows® 10 version 1607 and later (64 bit only) 
▲ Windows® 10 LTSB version 1607 (64 bit only) 
▲ Windows® Server 2008 R2 SP1 
▲ Windows® Server 2012 
▲ Windows® Server 2012 R2 
▲ Windows® Server 2016  

 
Extended Memory mode for an alarm server can only be run on a 64-bit operating system. 
 
The requirements for Microsoft .NET Framework are 4.0, 4.5.1, 4.6.1 and 4.7 (installed with Citect SCADA if not 
already installed). 
 
Microsoft .NET Framework 2.0 (x64) is required by "Schneider Electric License Manager" and "Schneider Electric 
Software Update" if using Windows Server 2012. 
 

  

Internet Explorer Version 9 or later is the minimum requirement when using the Process Analyst, the 
Citect SCADA Web Client, or the Citect SCADA Web Server. However, in line with Microsoft advice, 
we recommend you use the latest version of Internet Explorer with these products. 

For more information please refer to Chapter 4: Installation Requirements > Software system of the 
installation guide which comes with the Citect Scada disk or installer. 
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 File Inventory 
To ensure a smooth upgrade and minimal disruption during this process there are few files, apart from your 
project backup, that you will need to take from your current system. The number of files you need to collect will 
depend on if your system can tolerate loss of data, but still, there are several files you need to collect regardless of your system conditions. 
 
These files will depend heavily on your project configuration, and we recommend, when possible, contacting 
the developer of your project, since they will have the global picture of your project’s dependencies. 
 
In the table on the next page you will find a list of the files you need to backup from your current system, or 
where to look for these files based on your project settings. 
 

File Description 
Project backup (.ctz 
file) 

This is the main file to capture. 
You can do this from Citect Explorer: 
Citect ExplorerToolsBackup 
Please make sure you back up your project and all included projects. 

Citect.ini This file is found in the config folder 
Data directory This file is found on the path [CtEdit]Data 
ALMSAV.DAT and 
ALMINDEXSAVE.DAT 
(For 7.20 and previous 
versions) 
 
OR 
 
Alarm Database (For 
7.30 and 7.40) 

These files contain alarm configuration data as well as runtime data. 
Their path is defined on Citect.INI, or you can check Citect ExplorerTools 
 Computer Setup Editor [Alarm]SavePrimary 
Default path: Same as Data directory 
The alarm database will be found on your Data directory, using the following 
naming convention: [Data]\MyProjectName\ClusterName.AlarmServerName 
There will be as many databases as Alarm Servers you have on your project, 
please make sure you back up all of them. 

Trend files: 
.HST and .00X 

The path and names of these files is defined on the trend tag itself i.e.:  

 (screenshot for CitectSCADA 7.20 Trend Tags form) In this case, the files will be created on the data directory defined in 
[CtEdit]Data. The files will be named CPU.HST, CPU.001 and CPU.002 
(after the trend name and number of files) 
If the filename is left blank it will put all files in default DATA directory, with 
the trend tag name as filename. 
Default directory: Same as Data directory 
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File Description 
Report files These files contain the code that is executed on your Citect reports. They 

will always under [CtEdit]User\MyProjectName, and should be copied when 
you backup the project.  
These files names are defined on the reports form: Project 
EditorSystemReports 
 

 (screenshot for CitectSCADA 7.20 Reports form) 
Custom ActiveX 
controls (.OCX)  

Citect includes a number of ActiveX controls and most of these will be 
available with the Citect SCADA 2018 installation, but you need to backup 
your custom ActiveX controls. The developer of your project will know where these can be found. 
 
Alternatively, you can check the contents of the ActiveX.dbf file on your 
[CtEdit]User\MyProjectName directory. On this file you will find an inventory 
of all the ActiveX controls used in your project, and their GUID. 
 Using the GUID, you can find the path to the ActiveX, as defined in the 
windows registry key: 
KEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\"GUID"\InProcServer
32\ 
The default value for this key is a path to the .DLL or .OCX you need to backup. 

Device logs These files will contain any logging you have configured in your project i.e. 
alarm logs, reports logs.  
You will find their locations on the devices form: Project 
EditorSystemDevices 

 
  
 
 
 
  
 
 
 
 
 
 
 
 
 

    (screenshot for CitectSCADA 7.20 Devices Form)  
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When backing up files it is always useful to know the location for the Citect SCADA Data, User, Logs and 
Config folders.  
The current path for these can be found using the computer setup editor, or by looking at your Citect.INI file. To access the computer setup editor you can go to Citect Explorer > Tools > Computer Setup 
Editor  
 
Under this section you will find the Data, Logs, Config and User parameters, which contain the path 
under which to find these files. In older versions, the Computer Setup Editor didn’t exist, but you can 
still access the .INI file through the menu Citect Explorer > View > Citect.INI  
It is also good to know the default installation paths for these directories: 
 
Default path for Windows 7, Windows Server 2003-2012: 
C:\ProgramData\Schneider Electric\CitectSCADA 7.XX\  
Default path for windows XP: 
C:\Documents and Settings\All Users\Citect\CitectSCADA 6.XX\ 

 
 
 

File Description 
Additional Files  Check your citect.ini or use your computer setup editor, on the Paths Section 

as it could contain runtime files used by custom code in the project. 
Also, check your system parameters, and any parameter defined under the 
Paths section. 
You will find their locations on the Parameters form, and look for Path: Project EditorSystemParameters 
 

 (screenshot for CitectSCADA 7.20 Parameters form)  
In this example this path points to the Data directory, which you should have 
backed up already, but it might not be the case, so please double check. 

Driver Hotfixes If you are aware of any driver hotfix in your system, please backup this driver 
dll, which you’ll find on the BIN directory, with all SCADA program files. 
Also, be aware that the fixes contained in this hotfix may have already been 
included in the drivers which ship with Citect SCADA 2018. 
Additionally, you can check our Driver Web for the latest releases. 
 Table 2: File inventory: All the files you need to backup before upgrade 
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 Offline Upgrade Process 

 
Once you have figured out which kind of upgrade you need, outlined the upgrade path, checked your hardware 
and software requirements and backed up all necessary files, it is time to proceed with the upgrade process. 
 
Earlier in this document we asked you to answer a simple question: Can your system tolerate any downtime 
and loss of data? 
 
Based on your answer you will need an offline or online upgrade, as well as a determined upgrade path. 
 
Now that you have done all that, we will introduce the concept of an Offline upgrade. This is the basic upgrade process and it will be required whether or not you are going through an online upgrade. 
 
Please review carefully the steps to take in order to produce a successful offline upgrade. 
We will be using a starting version of 6.10 in this example. 
  
 

    
 
 
 
 
 
 

 
 
  
  Backup your current project and relevant files 
 

In this particular case, you need to be aware that 6.10 is not supported on Windows 7, and Citect SCADA 2018 is not supported on Windows XP, hence, this particular case would involve a change in Operating 
System, as well as on the default directory and paths definition. 
 
To perform a backup of your project go to Citect Explorer and select your project from the list, and then go 
to ToolsBackup… Please ensure you select Save sub-directories and Save configuration files is selected 
on the Backup dialog.  

There is a known performance limitation of the file operating system when more than 3000 files reside 
in the directory. Also, care must be taken if changing filename structure, as Trend server doesn’t 
support these types of changes. 
Please read KB article Q3823 for more information. 

Figure 2: Upgrade path for offline upgrade 
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  Upgrade your licenses 

In order to do this, your site will need to have a valid support agreement or you need to purchase a license 
upgrade. You can upgrade your key or soft license using our online license generator. You can also check 
the support status of the key or soft license at the same URL. 
  If your license is out of support, please get in touch with your Schneider Electric account manager/sales 

rep who will help you with pricing and guide you through the purchase process.   If your license appears as out of support, but you are not sure who your account manager is, please 
send an email to scada.orders@schneider-electric.com with your license and Site ID details or your 
purchase order information to sort out your support status. 

 
All our licenses are backwards compatible. Therefore, we recommend upgrading your license as a first 
step, since it will be valid for any Citect SCADA version on your upgrade path.  Plan your upgrade path 

Please keep in mind the changes you make to file locations when backing up and restoring custom 
files, as you will need to change the paths reference in the project to reflect the new file locations. 

To upgrade the key go to “Licensing” menu option from Citect Studio and use the Sentinel Key Update 
for USB dongle and Floating License Manager for Soft license. 
Also, if you are using soft licenses, please read KB article Q7698 before restoring your OS or using 
Virtual Machines that have soft license activations. 

Figure 3: Backup project dialog 
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If you need to preserve historical data, then you should follow the upgrade path described in this section. 
For this you will need to backup files and projects at every milestone of the upgrade path. Also, you will need to be able to install and run all versions of Citect indicated on the upgrade path. 

 
  Uninstall your current SCADA version 

In this particular case, you most likely need new hardware or a new OS, so this step would be unnecessary. 
In the case in which you don’t need to format your machine or a new machine in itself, we recommend 
uninstalling the older version and installing the newer version defined on your upgrade path once you have 
completely uninstalled the previous one. 
 
In this example (because the initial version was 6.10 and it’s only supported on Windows XP or earlier) you 
would need to restore the project in a new machine with Windows 7 or newer and Citect SCADA v7.20 SP4 
or SP5A. 
 After completing the first iteration of the workflow, you would need to uninstall v7.20 and install Citect 
SCADA 2018. 

  Restore your project 
The following steps you will need to repeat as many times as milestones you have on your upgrade path (It 
should not be more than two milestones if upgrading from v5.21 or greater).  
 
Please check the workflow in Figure 3 below for a better idea of the process: 

  
  Upgrade your project 

As default, when you restore a project from a previous version into 2018, Citect SCADA design 
environment will force an update, and you will get the following message: 

 
  

 
 
 
 
  
 
 
 

Once you make the project “Active” in Citect Studio the following warning message will pop up to upgrade 
the graphics to version 8.10 format:  
 
 
 

 
  

Figure 5: Warning displayed before updating a single project 

Figure 4: Upgrade projects progress status 
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Click “OK” button to upgrade the graphics to the new format. If you click “Cancel” the graphic pages will not 
be displayed at runtime.  
 
NOTE: If you do not go through the graphic upgrade process, the graphic pages will not be displayed at runtime. 

  Migrate your project 
The automatic update that occurs when you restore your older project into the newer Citect SCADA version 
does not fully upgrade your projects, and needs to be followed by the Migration Tool (if migrating from v6.x 
this is particularly noteworthy). 
 
The automatic upgrade is a passive action which updates the database field definition for any database that 
has been changed between the two versions and copies new files that are necessary in the current version.  
The Migration Tool is a separate application which should be manually run after the automatic upgrade has 
been executed. It can be initiated after you have prepared the project for final migration. This tool will 
accommodate the changes in project functionality that are incorporated in 7.0 through to the current 
version. 
 

This action may take a long time depends on the number of pages and genies you have in your 
project. This process will go through all the pages and genies and will update them to the new 
format. Once the pages are updated and you can make a change to a genie it will only update the 
pages this genie belongs to instead of going through all the pages. 
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To use the Migration tool, make your project active in Citect Studio and go to Projects view and then click 
on “Migration Tool”.  
 

  
You will be presented with the following dialog: 

   
 
Please find in the next table a description of what every option does. 

Before you use the migration tool, it is advisable you backup your upgraded projects. Some of the 
changes this tool makes are not easily reversible, and, if you interrupt the migration process 
before it’s finished you will need to restore your original project and go through the upgrade and 
migration process again. 

Option Description 
Remove obsolete 
Memory and Alarm 
devices 

Select this check box if you wish to delete these types of 
devices after successful migration 
Note: Do not select this check box when you run the tool for the 
first time on a project that contains any included projects which 
are shared with more than one master project. If you want to 
delete obsolete devices under these circumstances, you can 
run the tool a second time using this option if the migration is 
successful after it is run the first time. 

Append to existing log 
file 

Use this option to append information about the migration 
process to the existing Migration Tool log file (located in Citect 
SCADA's User directory). If this option is not selected, a new 
log file will be created when migration is complete. 

Create roles from User 
security information 

Select this option if you wish to migrate the users’ database 
from an existing project. 

Figure 6: Citect SCADA 2018’s Migration tool 
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  Merge your .INI file 
So far, you should have been using the default .INI file that comes with the default installation of the version 
you are upgrading to. We do not recommend replacing your old .INI file into the new version, since it is likely 
that many parameters have been deprecated or changed behaviour. 
 
However, we do recommend paying special attention to the following parameters, as they will be necessary 
to compile your project correctly and to set your design environment to your preferences. 
 
If the following parameters are defined in your old .INI file, please ensure they are merged into the new 
version’s .INI file: 

 

Copy XP_Style menu 
into Tab_Style menu 

Select this option to convert legacy menu entries to the format 
necessary for the new menu configuration system. By default, 
this option is unchecked to avoid potential compile errors that 
may occur if the legacy menu.dbf contains functions which 
have been removed. 

Migrate included 
projects 

Select this option to migrate the included projects associated 
with the selected project. 

Migrate equipment 
database 

Select this option if you have an existing equipment database 
that you want to migrate into this version. When upgrading from 
an earlier version, and the "PARENT" field of the equipment 
table was used, you should select this check box. Otherwise 
existing data from the PARENT field will be ignored. If runtime 
browsing is used, the PARENT field will return the equipment 
parent (the substring of the equipment name without the last '.' 
and anything after that). To retrieve information that was stored 
in the previous "PARENT" field the "COMPOSITE" field should 
be used. 

Migrate ABCLX to 
OPCLX 

Select this option if you want to migrate devices that currently 
use the ABCLX driver to the OPCLX driver. Select the Configure 
button to indicate which I/O devices you would like to migrate. 
Note: You should confirm that the OPCLX driver is installed 
before you use this option. 

Migrate Trend/SPC 
storage method 

If you select this option, the storage method will be set to 
scaled (2-byte samples) for all trends that have no storage 
method defined. Use this option to stop the compiler error 
message "The Storage Method is not defined". In previous 
versions, a blank storage method would default to scaled. 
However, this is no longer supported, resulting in a compilation 
error. 

Parameter 
[Section] Name = Value 

Description 
[General] 
TagStartDigit=1 

Without this parameter you will encounter the ‘Tag not 
defined’ compiler error. Setting this to one, allows to 
define tag names that begin with numbers or symbols. 

[General] 
CheckAddressBoundary=0 
 

Without this parameter you could encounter the ‘Bad Raw 
Data’ or other tag address related errors. Setting this to 
zero, allows defining variable tags of the same data type in 
odd or even addresses. When this parameter is set to 1, all 
variable tags from the same data type must be defined on 
odd OR even addresses. 

Table 3: Options for Citect SCADA 2018’s Migration Tool 
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Also, please merge any driver parameters from your old .INI file as they will most likely be necessary to 
interface with your I/O network. 

  Compile your project 
 After upgrading and migrating your project, you need to ensure runtime functionality works as it used to. As 

usual, you need to successfully compile your project before going to runtime.  
When upgrading from previous versions, it is not uncommon to encounter compiling errors, particularly if you 
are upgrading from a very mature version. 
 
One of the most common sources of compiling errors when upgrading is Cicode functions. This is because 
the functions have been added, changed, deprecated, or simply because the compiler has become stricter to help you better prevent runtime errors. 
 
You can find a list of the new, modified, reinstated, deprecated and removed cicode functions in the product 
help: Getting Started > What's New in Citect SCADA > What's New in Citect SCADA 2018 > Cicode 
Functions in Citect SCADA 2018.  
 After clearing all the compiling errors, you need to ensure that your project is compiled in its entirety. To do 
this, please make sure that Incremental Compile is turned off. 
 
To do this, go to Project EditorToolsOptions and un-tick Incremental Compile. 

  
 
 
 
 
 
 
 
 
 
 
  
 

[CtDraw.RSC] 
ListSystemPages=1 
 

This allows you to open popup pages from the Graphics 
builder. 

[CtDraw.RSC] 
AllowEditSuperGeniePage=1 
 

This allows you to edit super genie pages from the 
Graphics Builder. 

Table 4: Citect.INI parameters to be merged from your OLD Citect.INI file. 
          Please add these parameters ONLY if they are found on your old .INI file 
 

Figure 7: Project Editor’s options: Disabling Incremental Compile 
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The most common compiling errors when upgrading can be found on the product documentation: 
Compile > Compile a Project > Compile Messages > Compile Error Messages.  
 After that, please Pack, Update Pages and Pack Libraries on your included projects before compiling 
one last time. 

  Run the Computer Setup Wizard 
Before running a project for the first time, you need to run the Computer Setup Wizard. This wizard is 
used to configure the Runtime Manager and other settings that are relevant to the runtime process. 
   
The computer setup wizard will automatically determine your computer role based on the network 
addresses you have defined in your project. 
  
After finishing the computer setup wizard, you can proceed to restore your historic data and other files 
and run the project. 

 

  Restore runtime files 
After compiling your project, you’ll want to ensure that all the files necessary for runtime are placed in the 
correct directories. For this, you’ll need the files you collected in File Inventory and you need to place the files in the corresponding directories, as defined in your .INI file and project configuration. Please read the 
note in this section for more information. 

  Restore historical data files 
The last step before running your upgraded project is to restore the historic data files. 
 
Alarms: 
 For versions prior to 7.30: 
In this example, and whenever upgrading from a version earlier than 7.20 SP4, particular attention needs to 
be given to the ALMSAV.DAT and ALMINDEXSAVE.DAT files. 
 

Incremental Compile is an option that allows faster compiling, by only compiling the latest changes to 
the project. This is necessary on large scale projects in which a full compile can take several minutes. 
We recommend only enabling this option after deployment/development of the project is finalised, or 
when introducing small, limited changes. 

If your local address is not a part of the Network Addresses of your project (or any included project), 
the computer setup wizard will default the role of the computer to Client. If your computer is meant 
to be a server, you need to add the local address to the Network Addresses definitions and server 
instances of your project. 
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The reason why 7.20 SP4 is an intermediate step in the upgrade path for these versions, is precisely that 
7.20 SP4 contains the code that will convert these files into a format that can be read by the new alarm server architecture, introduced in v7.30, and maintained in Citect SCADA 2018. 
 
Follow these steps to convert the files: 
 

1. Take a copy of the ALMSAV.DAT and ALMINDEXSAVE.DAT from your existing project (previous 7.20 
SP3 and below versions) 

2. Place the files in 7.20 SP4 or SP5 machine and point [Alarm]SavePrimary parameter points to the 
directory in which you have placed your backed-up ALMSAV.DAT and ALMINDEXSAVE.DAT. 

3. Run the project and verify you can see the alarm data, then take the new ALMSAV.DAT and 
ALMINDEXSAVE.DAT files, as you will need to repeat this process when you upgrade to Citect 
SCADA 2018 (for an offline upgrade). 

For versions 7.30, 7.30 SP1 and 7.40: 
 
Whenever upgrading from a version between 7.30 and 7.40 SP1 particular attention needs to be given to the 
Alarm Database on the Data directory of the project. 
 
Follow these steps to convert the files:  

1. Make sure to place your backed-up Alarm Database on the directory defined by the [CtEdit]Data 
parameter. 

2. Before starting runtime, please confirm that the directory that [Alarm]SavePrimary does NOT contain 
ANY ALMSAV.DAT nor ALMINDEXSAVE.DAT files. 

3. After you run and verify the project, take the new Alarm Database, as you will need to repeat this 
process when you upgrade to Citect SCADA 2018. 

 
Trends: 
 
Follow these steps to convert the files: 
 1. Create the same file hierarchy on the new system. 

2. Place the files in the same folders. 
3. If you want to change the folder location, or you cannot replicate the same file hierarchy, please use 

the trend renamer tool: 
http://www.citect-kb.schneider-electric.com/ToolBox/KnowledgebaseArticle1244.aspx   

 Run your project 
By now, your project should be ready to run. Now, it is a matter of checking all previous functionality works 
as intended, now that you have successfully upgraded from version 6.10. 
 
As a rule of thumb, you need to check any Cicode that you needed to modify to compile in the new version. 
 
You also need to test communications to your I/O devices, Alarm triggering and Trend capture are working ok. 

  Install Citect SCADA 2018 
After you have completed all the milestones in your upgrade path, you will be ready to install Citect SCADA 
2018. 
 
Once your environment is clean from previous versions, you can proceed to install Citect SCADA 2018. If you are not familiar with previous versions of Citect SCADA, we suggest following the process outlined in 
the installation guide available with the installation files. You can download the Citect SCADA 2018 
Installation guide from our website. 
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 Troubleshooting Offline Upgrade 
 
In this section, we will list common issues you might encounter during your Offline Upgrade which will be 
related to Compiling Errors and any other pre-runtime matters: 
  Cannot upgrade License Key 
 

1. Please make sure you have correctly installed the latest versions of CiUSafe and Sentinel Driver. 
2. Please make sure the Authorization code matches the Key you are trying to upgrade. If you still cannot 

upgrade your license, please check KB article Q3672 for more information on the error codes. 
 

We recommend checking our knowledge base for useful information. 
To search specifically for upgrade issues, you can select the Upgrade issues category on the left pane of the 
page. Alternatively, use this link for direct access to this category.   Compiler errors and warnings that are not related to deprecated 

functions 
As Citect SCADA evolves, the compiler feature becomes stricter in order to ensure project quality and 
runtime success. The fact that you are getting compiling errors that were not appearing before is a symptom of stricter compilation, which will result in more predictable and stable runtime. 
 
Citect SCADA 2018 includes a new feature that will help you understand compiling warnings and fatal 
errors easier. There is a new field included in the compiling record: 
 
 
 
 
 
 
 
  
If you search for ‘E2021’ in the Citect SCADA 2018 help, you will find more information for this specific error 
code. In this example: 
 

 
 
  Figure 9: Help topic for error E2021 

Figure 8: Compile error form 
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  Online upgrade process 
 
Now that you have learned how to do an offline upgrade, you can proceed to complete the online upgrade. 
 
An online upgrade takes advantage of Citect SCADA’s native Server redundancy to minimize or avoid loss of data 
or downtime on your production system, allowing for one server to take ownership while the other is being 
upgraded. 
 
Also, it is important to note that an online upgrade is the only way to avoid loss of data. It is a customary practice in 
the industry to perform an upgrade in parallel. This is the process in which the two SCADA systems (the old version 
and the newer one) are running side-by-side. The old version is decommissioned after the new version has been 
fully tested and validated. 
 
Using an upgrade in parallel approach, it is not possible to convert the data for the time in which the new version is 
being brought online, even if restoring historic files from the older version that is online at the same time. There will 
always be a data gap from the time you take the historic files, to the time you start your parallel SCADA system. An 
online upgrade is the only way to avoid loss of data. 
 
Similar to the offline upgrade, you will need to follow the upgrade path, and repeat the process as many times as 
milestones you have in your upgrade path (It should not be more than two milestones if upgrading from v5.21 or 
greater). 
 
In this chapter we will list the pre-requisites for an online upgrade, and discuss two scenarios considering the 
starting version: from 7.20 SP4 or SP5A and from 7.40 SP1. 
 
Pre-requisites 
As discussed previously, the online upgrade will allow you to avoid downtime and loss of data. 
 
It is important that you take into consideration the complexity and size of your project when planning for this 
upgrade. 
 
As you saw in the previous chapter, an offline upgrade can be a complex process, and it is important this has been 
completed thoroughly in order to avoid downtime and loss of data in your production system. 
 
Please read the list of pre-requisites below before you start the online upgrade: 
 
At least one pair of redundant servers: this is to upgrade one server at the time, while the redundant server 
assumes primary operation, avoiding downtime and loss of data. 
 
Upgraded project: make sure your project runs and works properly on Citect SCADA 2018 before deploying to 
production and starting the online upgrade. If your project is complex or you are upgrading from a version earlier 
than 7.20 SP4, it is strongly recommended that you have a test environment, as the offline upgrade could be 
complex and could involve a long server downtime if done on your production system. 
 
Restore runtime files: ensure you have restored the necessary files for runtime onto the appropriate directories to 
avoid any disturbances on the upgraded live system. 
 
Capture data files: to allow historic data to be restored into the new version, you need to capture the data files at 
the right time. This is described in detail in the online upgrade steps outlined below. 
 
Configure your running system for Online upgrade: to allow this process to be as smooth as possible, we 
recommend leveraging of your current redundant system and adding the following citect.ini parameters before the 
online upgrade: 
 



Upgrading to Citect SCADA 2018 PAGE 25 OF 33

 

 
 

▲ [LAN] EarliestLegacyVersion: use 7200 for 7.20 upgrade and 7400 for 7.40 upgrade. This will allow your 
upgraded servers to accept connections from the older version 

▲ [Alarm]EnableStateLogging: set this parameter to 1, as it will allow logging the alarm synchronization 
messages into the syslog. The importance of this will be addresses in upcoming sections 

▲ Alarm.<ClusterName>.<AlarmServerName>]KeepOnlineFor: This parameter is configured for each Alarm 
Server instance and default to 6 weeks. 
 
When configuring this parameter you need to decide what time period of data you want to keep online after the 
upgrade has finised, when running your system.  
In a redundant setup this should be the same on the primary and standby alarm server. 

▲ [Alarm.<ClusterName>.<AlarmServerName>]ArchiveAfter: This parameter is configured for each Alarm 
Server instance and defaults to 4 weeks. 
 
When configuring this parameter you need to decide what time period of data is that you wish to maintain during 
upgrade. For example, if you set this parameter to 1 week, it means that during the upgrade process you will 
lose any summary data that is older than 1 week. If you don’t want to lose any data, you need to set this 
parameter to the earliest data in your summary (7.20) or SOE (7.30 and above). 
In a redundant setup this should be the same on the primary and standby alarm server. 
 
Note: ArchiveAfter has to be smaller than KeepOnlineFor. 

▲ [Debug] Kernel = 1 (optional): we recommend enabling this to allow you to monitor the kernel during the 
upgrade. Specific situations in which you can check the kernel will be highlighted in later sections 

  Online Upgrade steps: 7.20 to Citect SCADA 2018 
In this particular scenario, you will NOT need to restore the alarm data files (ALARMSAV.DAT and 
ALRMSAVEINDEX.DAT) under most circumstances.  
To enhance your experience during the online upgrade process, Citect SCADA 2018 is equipped to read 
this information from the redundant 7.20 (SP4 or greater) server that is still not upgraded. 
 

1. Add the following parameter on the .INI file to all your server nodes before you start the online upgrade. 
[LAN]EarliestLegacyVersion = 7200. 
You will need to restart the servers after adding the parameter for the changes to take effect. 

2. Shutdown SCADA runtime on the Primary server  
3. Upgrade Citect SCADA on this server according to the offline upgrade procedure. 
4. Restart the primary server, now upgraded. 
5. Now, the Citect SCADA 2018 server will build the new alarm database, and will import the historic data 

from the Standby 7.20 server. 
6. Please check the status of the alarm server synchronization using the Alarm Server Kernel, on the Main 

Window: 
▲ When the Alarm Servers synchronization starts you should see the following message: 

Alarm: Peer update request sent. 
▲ Then you should see a number of messages with Update packets (number is dependent on your 

Alarm historic events and configuration). 
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Alarm: Update packet XXXX received. 
▲ Finally, the following messages will indicate that the synchronisation has been finalised successfully: 

Alarm: Database objects state synchronization completed. Alarm: Database is initialized, preparing to Start the Alarm Engine. 
Alarm: Starting Alarm Engine 
Alarm: Server startup complete. 

7. If you find that your Alarm Server synchronization cannot finalize, please place the ALARMSAV.DAT 
and ALRMSAVEINDEX.DAT on the [Alarm]SavePrimary directory. Please note that this should be a last 
resort. 

8. Upgrade your client nodes one by one. 
9. Once you are confident that synchronization of alarms, trends etc., is complete, and that your 2018 

clients are working correctly, shutdown runtime on the Standby server. 
 

10. Upgrade Citect SCADA on this server according to the offline upgrade procedure. 
11. Restart the Standby server, now upgraded. 
12. Once the Standby is running fine, check for hardware alarms on connection to Primary. 
13. Check functionality of the system as a whole. 
14. Finally, test redundancy by switching off the Primary server and assuring Standby takes over and 

Clients switch over. 
 7.1.1. Special Considerations: 7.20 to Citect SCADA 2018 
 

Custom Alarm Filtering 
 
The AlarmSetQuery CiCode function was deprecated in 7.30. This means that if you are using custom 
alarm filtering code, you will most likely need to convert it. 
Please refer to the following help topic for more detailed help with this process Using Citect SCADA > Alarms > Using Custom Alarm Filters > Converting Legacy AlarmSetQuery Functions.  
 
 
Alarm server synchronization during online upgrade 
 
As part of Citect SCADA 2018 development efforts, we have spent time ensuring and testing the online 
upgrade from 7.20. This process should go smoothly as long as you follow this guide. However, in the 
event that there is a disconnection or timeout during synchronization between the 2018 and 7.20 alarm 
servers you only need to shutdown your 2018 server, delete the alarm database and re-start it again 
and wait for the synchronization between servers to finish. 
Also, you can increase the timeout using the [Alarm]StartTimeout .INI parameter. This will allow the 
2018 server to wait for connection from its 7.20 peer. 

Please be aware that during this stage, the client nodes will only communicate with their 
corresponding server. 
A 7.20 client will not be able to communicate with Citect SCADA 2018 Server. Likewise, Citect 
SCADA 2018 Client will not be able to talk to v7.20 Server. 
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If you find that the synchronization between the two servers is failing repeatedly, then you can delete 
the alarm database, and place your ALARMSAV.DAT and ALARMSAVINDEX.DAT on the [Alarm]SavePrimary directory and the 2018 server will convert the data. However, we recommend 
always trying the peer synchronization first.  

 
Changes during the upgrade process 
 
Because of the differences between Citect SCADA 2018 and 7.20, any actions that happen during the 
online upgrade process are subject to the incompatibilities that are not reconcilable between versions. 
However, the scenarios are quite particular and should not have a great impact if any, on your SCADA 
system’s ability to fulfil its purposes.   
 Online Upgrade steps: 7.40 SP1 to Citect SCADA 2018 

 
1. Make sure you have added the following parameters on the .INI file to all your server nodes before you start the online upgrade.  

[LAN]EarliestLegacyVersion = 7400. 
You will need to restart the servers after adding the parameter for the changes to take effect. 

2. Shutdown SCADA runtime on the Primary server  
3. Upgrade Citect SCADA on this server according to the offline upgrade procedure. 
4. Place the backed-up Alarm database on the [CtEdit]Data directory. This will allow a quicker 

synchronization of alarm servers. 
5. Restart the primary server, now upgraded. 
6. Now, the Citect SCADA 2018 server will synchronize its alarm database with the running 7.40 SP1 

server. You need to wait for the synchronization process to finish, and this will depend on the size of 
your alarm database. The synchronization information is available from the main kernel window of the Alarm Process as well as the syslog. 

7. Upgrade your client nodes one by one. 
8. Shutdown runtime on the Standby server. 
9. When the newly upgraded 2018 server assumes the primary server role it will migrate the entire alarm 

database to the new format, and you should now be able to see Alarm Summary data on all migrated 
Clients. 

10. Upgrade Citect SCADA on this server according to the offline upgrade procedure. 
11. Restart the Standby server, now upgraded. 
12. Check functionality of the system as a whole. 
13. Finally, test redundancy by switching off the Primary server and assuring Standby takes over and 

Clients switch over. 

Once the Citect SCADA 2018 has created the Alarm Database it will not attempt to read alarm 
history files nor try to synchronize with its 7.20 peer. This is why you need to delete the Alarm 
Database before attempting conversion of files or peer synchronization. 

Due to technical limitations Citect SCADA 2018 nodes will not be able to display Alarm Summary 
data until after the upgrade. 
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 7.2.1. Special Considerations: 7.40 SP1 to Citect SCADA 2018 
 Alarm Summary 

The v2018 Summary feature will be disabled when connecting to a v7.40 server. You may still see 
summary records for active alarms. 
 
Alarm Save files 
When doing an online upgrade from 7.40 SP1 to 2018 please ensure that any pre 7.20 Alarm Save files 
are removed from the 2018 project folders (e.g. <project_cluster>_ALMSAVE.DAT and 
<project_cluster>_ALMINDEXSAVE.DAT). 
 
Historical Alarm Events 
Set the  [Alarm.<Cluster Name>.<Server Name>]KeepOnlineFor and  [Alarm.<Cluster Name>.<Server Name>]ArchiveAfter .INI parameter to a date prior to the earliest historical event date from which you 
want to migrate. 

  Upgrading from v2015  
To upgrade from v2015:  
1. Check that you have SP1, Patch 6 or later installed. For instructions on upgrading to this version, refer to 
the v2015 documentation.  
2. Check that you have added the following parameters on the .INIfile to all your server nodes before you 
start the online upgrade.  
[LAN]EarliestLegacyVersion = 7500  
Restart the servers after adding the parameter for the changes to take effect.  
3. Shutdown SCADA runtime on the primary server  
4. Upgrade Citect SCADA on this server according to the offline upgrade procedure.  
5. Place the backed-up Alarm database in the [CtEdit]Data directory. This will allow a quicker synchronization ofalarm servers.  
6. Restart the primary server, which is now upgraded.  
7. Citect SCADA 2018 server will synchronize its alarm database with the running v2015 server. You need 
to wait for the synchronization process to finish, and this will depend on the size ofyour alarm database. 
The synchronization information is available from the main kernel window ofthe Alarm Process as well as the syslog.  
8. Upgrade your client nodes one by one.  
9. Shutdown runtime on the standby server.  
10. When the newly upgraded v2018 server assumes the primary server role it will migrate the entire alarm 
database to the new format, and you should now be able to see Alarm Summary data on all migrated 
Clients.  
11. Upgrade Citect SCADA on this server according to the offline upgrade procedure.  
12. Restart the standby server, which is now upgraded.  
13. Check functionality ofthe system as a whole.  
14. Test redundancy by switching offthe primary server and assuring standby takes over and Clients switch 
over. 
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 7.3.1. SpecialConsiderations: 2015 SP1 Patch 6 to Citect SCADA 2018 
Alarm Save Files 
When doing an online upgrade from v7.50 to v2018 check that any pre-7.20 Alarm Save files are 
removed from the v2018 project folders (e.g. <project_cluster>_ALMSAVE.DAT and 
<project_cluster>_ALMINDEXSAVE.DAT). 

  Upgrading from v2016  
To upgrade from v2016:  
1. Check that you have the release version installed. For instructions on upgrading to this version, refer to 
the v2016 documentation.  
2. Check that you have added the following parameters on the .INI file to all your server nodes before you 
start the online upgrade.  
[LAN]EarliestLegacyVersion = 8000.  
Restart the servers after adding the parameter for the changes to take effect.  
3. Shutdown SCADA runtime on the primary server  
4. Upgrade Citect SCADA on this server according to the offline upgrade procedure.  
5. Place the backed-up Alarm database in the [CtEdit]Data directory. This will allow a quicker 
synchronization ofalarm servers.  
6. Restart the primary server, which is now upgraded.  
7. Citect SCADA v2018 server will synchronize its alarm database with the running v2016 server. You need 
to wait for the synchronization process to finish, and this will depend on the size ofyour alarm database. The synchronization information is available from the main kernel window ofthe Alarm Process as well as 
the syslog.  
8. Upgrade your client nodes one by one.  
9. Shutdown runtime on the standby server.  
10. When the newly upgraded v2018 server assumes the primary server role it will migrate the entire alarm 
database to the new format, and you should now be able to see Alarm Summary data on all migrated Clients.  
11. Upgrade Citect SCADA on this server according to the offline upgrade procedure.  
12. Restart the standby server, which is now upgraded.  
13. Check functionality ofthe system as a whole.  
14. Test redundancy by switching offthe primary server and assuring standby takes over and Clients switch over. 
 

  Troubleshooting Online upgrade 
 

The issues you might encounter during your Online Upgrade will be related to runtime issues and 
redundancy connectivity. For pre-runtime issues such as Compiler Errors please refer to this section. 
 It is important that your redundant servers are in communication during the upgrade, otherwise, it is not 
really an Online upgrade and you will end up losing data. 
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My redundant servers fail to communicate 
I cannot make my redundant servers communicate and I keep getting the hardware alarm “Redundant Server not found” 
 
1. Please make sure you have set your [LAN]EarliestLegacyVersion parameter correctly. 

a. In the case you are upgrading 7.20 use [LAN]EarliestLegacyVersion=7200. 
b. In the case you are upgrading 7.40 use [LAN]EarliestLegacyVersion=7400. 

2. Please make sure you have run the computer setup wizard and set both servers to Networked mode: 
3.  Also, make sure to set the same server password on both servers on the computer setup wizard:  

 
 
 
My system is performing slowly even though Hardware and software requirements are met 
Please check your system’s power options: Control Panel All Control Panel Items  Power Options.  
 
 
 
 
 
 
 
 

This is particularly relevant on Windows Server machines, which have this option enabled by 
default. 

Figure 10: Computer Setup Wizard: Server Authentication section 

Figure 11: Windows’ Power Options 
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Remove Upgrade related parameters 
After finalizing the upgrade process and confirming that runtime is fully functional, we recommend removing or updating the following .INI parameters accordingly. You will need to restart the servers after changing 
the parameters for the changes to take effect. 
 

• [Alarm]SavePrimary: please remove. 
• [Alarm]SaveStandby: please remove. 
• [Debug]Kernel = 0: this is to enhance security and keep operators out of the kernel. • [LAN]EarliestLegacyVersion: please remove. 

It is important to note that after removing the EarliestLegacyVersion parameter, the next time you change 
your user’s passwords, we recommend you change all the passwords on one server, and then roll out the 
updated project in the same order in which you conducted the online upgrade (Primary Server, Clients, and 
finally, Standby Server). Please read KB article Q7865 for more information.  
Upgrade third party applications 
Please ensure that any CtAPI client is upgraded to use the DLL’s included in Citect SCADA 2018. Keep in 
mind that you also need to be aware of the User password’s changes. Please read KB article Q7866 for 
more information.  

 

For a complete list of the DLL’s you need to upgrade, please read the Technical Reference > 
CtAPI Functions help topic. Also available online. 
Also, if you find that upgrading your CtAPI clients is not possible, please get in touch with Citect 
support for further clarifications. 
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 Reference to knowledge base articles  
 
Q8998: Cannot Convert Project Error in Graphics Builder  
      
Q8982: Web Client error of "An AsyncTaskBuffer was disposed in it's finalizer ... "   
Q8960: Symbol search failed compile error pointing to ACCUMS.DBF   
Q8951: Pulse() Used With the IfDef() Macro Causes Compile Errors  
      
Q8944: Symbol search failed compile error after installing the latest patch.  
      
Q8920: Citect OPC DA Server no longer runs as a service after installing an update (Service Pack or 
patch) to Citect 2015(7.50).  
  
Q8892: MsgRPC or ServerRPC Cicode doesn't work after upgrading to Citect SCADA / Vijeo Citect 
2015  
 
Q8887: OFSOPC Standby device activates items while being on standby mode  
  
Q8884: Floating License Manager in Vijeo Citect 2015  
  
Q8875: Web Client Quick Start Guide for Vijeo Citect 2015 (7.50)    
Q8874: Citect Runtime Manager does not start properly on a machine with more than 32 logical 
cores  
  
Q7873: User privileges not respected by Alarm Summary cicode functions  
  
Q7866: Updating CTAPI clients to be compatible with Vijeo Citect 2015  
  
Q7870: Creating Custom .NET DLLs in Vijeo Citect 2015 
  
Q7869: Migrating an Engineered Solution to the Run as a Windows Service Feature in Vijeo Citect 2015 .
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